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Strengthening Connections: 
Building a Newsletter for 
your Co-op
As home care cooperatives adopt new technologies that 
automate tasks such as filling in time sheets, submitting 
reimbursement forms and distributing paychecks, workers 
are finding fewer reasons to visit the business office. The 
result: increased efficiencies, but decreased opportunities 
for members to share information, offer support and learn 
from the experience of colleagues. 

An in-house newsletter can help co-op members keep 
in touch with each other and stay informed about 
the business they own. CDF has developed a new 
communications tool to help you get started. Our toolkit 
provides four newsletter templates with easy-to-edit 
layouts, a user guide with instructions on how to add 
pictures and text and suggestions for content. Toolkit 
users also have access to a file of home care related 
pictures, graphics and articles through CDF’s Home Care 
Cooperative Initiative webpage.

This newsletter guide is built based on advice from 
experienced members of four home care cooperatives. 
The experts suggested:

• Keep it manageable to edit and quick to read – the 
printable newsletter should be one-page, double-sided, 
with quick and useful information for busy people. 

• Build a calendar – for easy, stick-on-the-fridge reminders 
about important dates.

• Celebrate caregivers – include announcements about 
birthdays, anniversaries, newborns and important 
personal milestones.

• Promote professional support and growth – with questions 
from novices and hints and suggestions from experienced 
caregivers, as well as information about training and 
education opportunities.

• Help caregivers get to know each other – with short 
profiles of new co-op members and acknowledgements of 
the contributions of long-time members.

Spaces for all of these items, and more, are included in the 
toolkit’s templates. Also included: 

• A section for business metrics - to keep business co-own-
ers fully informed about the financial health 
of the co-op.

• Some help with the numbers – analysis to help owner 
members interpret the metrics:  What does it mean to 
the business when clients are added or lost? What’s the 
business impact of providing reimbursement for travel 
expenses? How is the recruitment drive for providers going?

• Executive Board Bulletin – to keep owner members 
engaged and aware of Board decisions and policy changes.

• News about what’s happening in the home care co-op 
industry nationally – so that providers will feel part the 
wider community by staying on top of developments 
affecting home care workers nationally. 

• Feedback from clients - to encourage and inspire.

Publishing Tip: According to our experts, newsletters 
are most useful when they are published at the end 
of each month, to provide news about happenings 
at the business in those four weeks, and a look at the 
month ahead.

Advice From The Experts
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Getting Started

The home care templates were created using Microsoft 
Word 2016. See TROUBLESHOOTING on p. 11 if you are 
working with a much earlier version of Word and have 
difficulty with formatting.

To help maximize the impact of your newsletter, CDF has 
compiled a collection of homecare related photos, images, 
graphics and written content for your use. You may find 
it useful to download some of those images onto your 
computer before you begin. 

To view available content, start at the Home Care 
Cooperative Initiative web page.

https://www.cdf.coop/homecare-cooperative-initiative

Click on the RESOURCES tab (at the top right of the page). 

Or, scroll to the bottom right of the page and access the 
resource page there. 

You’ll also find four newsletter templates on the CDF 
Newsletter Resources page, in a file called Newsletter 
Templates. Each template has generally the same format, 
but with spaces for different kinds of content. You may 
download all four templates, or just one. 

To download a template, return to the Home Care 
Cooperative Initiative webpage.

Click again on RESOURCES and look for Newsletter 
Resources, under which you will find Newsletter Templates.  
There are four templates for your use.

 Home Care Newsletter Template 1
 Home Care Newsletter Template 2
 Home Care Newsletter Template 3
 Home Care Newsletter Template 4

To download, click on the template, and store it in an 
appropriate computer file.

Once you have downloaded your template(s) and stored 
them on your computer, open up your version of Microsoft 
Word. From the Quick Access Toolbar at the top of your 
screen, click on FILE and then OPEN. You can also open the 
document directly from the list of recent files Microsoft 
will show you when you open Word. Find and highlight 
Home Care Newsletter Template 1 with your cursor and 
then click OPEN.

Once you’ve accessed the RESOURCES page, look for 
Newsletter Toolkit Resources.  

Under Newsletter Toolkit Photos and Graphics, you’ll find  
three links on the Newsletter Photos and Graphics page:

 Newsletter Toolkit Photos
 Newsletter Toolkit Graphics 
 Maps:  Home Care Cooperatives in the U.S.

COMPUTER TOOLS YOU’LL NEED

STEP ONE: ACCESS IMAGES AND TEXT FROM CDF

STEP TWO: DOWNLOAD THE 
NEWSLETTER TEMPLATES

Clicking on the Photos and Graphics links will bring you 
to CDF’s Home Care Cooperative Initiative facebook page, 
where you will find an album of photos you may use as 
well as an album of graphics.  

To download a photo or graphic from the Facebook 
album, right (or control) click on the photo, chose Save 
Image As, rename the photo, choose a file where you’d 
like to store the photo on your computer and click Save.
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When you open Template 1, you’ll see the first page of 
the newsletter:

Your front page begins with a banner that holds the 
name of your newsletter, your co-op motto and logo as 
well as a space above for your co-op name and the issue 
and date of your newsletter. At the bottom is a footer to 
hold your address, phone number and web address. In 
between are sections for the information your members 
need: a calendar, office updates, birthday and anniversary 
announcements and facts to inspire and inform your 
members.

STEP THREE: CUSTOMIZE YOUR TEMPLATE

Creating Your 
Newsletter Banner

Your newsletter banner is important because it is the first 
image your readers will see. Customize and standardize 
your banner so that it is a reliably consistent feature of 
every issue. 

Enter your co-op name by opening the header of your 
document.  To access the header, right click over Co-op 
Name and select Edit Header.  Or, select View from the 
tool bar at the top left of the tool bar.  Select Header and 
Footer.  Your document’s header will be revealed and your 
cursor will appear to the left of Co-op Name. Highlight 
the text that is there and replace it with the name of your 
co-op. 

Then, move your cursor over to Issue, Date. Highlight 
and replace that text with the issue and date of your new 
newsletter.  Exit the header by clicking View again and 
then Header and Footer.  Or, click on the Close Header and 
Footer box at the top right of the toolbar. 

If you prefer a different name for your newsletter, click on 
the text box containing the document name.  Highlight 
and delete the old name and replace it with your own.

CO-OP NAME

NEWSLETTER TITLE

Getting Started (contin-

Sizing Tip: If your name is too big for the text box, 
adjust the size by highlighting the text. Right click 
on the highlighted text and choose Font.  Lower the 
size from 44pt to something smaller.  Click ok. Repeat 
until you  achieve a size that fits.
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Once you’ve imported your logo, you will likely find that 
the image is too large for the designated space in your 
banner. To adjust, click on the new photo, and move your 
cursor to the bottom right of the image, where a small 
double headed arrow will appear. 

Drag that arrow in or out until you are satisfied with the 
size of the image. Then release your cursor to set the size.

Now your header is complete.

Your logo is an essential point of recognition for clients, 
prospective clients and providers. Create maximum 
impact by making it one of the first images readers see – at 
the top left of your newsletter. 

Replace the template logo with yours by right clicking on 
the temporary image. You’ll see a menu of actions. Choose 
Change Picture. You’ll find a menu of options:

To edit the footer, click on View in the toolbar and then 
select Header and Footer again. Scroll down to the bottom 
of the page. Double click on ‘Address’ in the bottom left 
hand corner. Replace that text with your co-op’s address. 
Repeat this step with your co-op’s phone number and 
e-mail, which can be found in the bottom center of the 
footer, and the right side of the footer with your co-op’s 
website. Do not worry about changing this information on 
every page; the program will do that for you automatically.

Exit the footer by clicking on View again, then Header 
and Footer.  Your cursor will return to the body of your 
newsletter.

There is a space at the very bottom of your newsletter 
for your co-op’s contact information in the document 
footer. As with the header, the information you enter in 
this section will remain the same for every issue of your 
newsletter once you have made your initial changes.

Select Picture from File…

Microsoft Word will direct you to the files available on 
your computer. Choose a quality version of your logo from 
your image files. Suitable images will have a .png or .jpg 
extention. Select the file with your cursor, then click on the 
Insert button on the bottom right of your file box. 

Your new photo will appear in your banner.

ADD YOUR CONTACT INFORMATION

Once you have completed your  banner, header and 
footer, save your newsletter for use as a template for all 
future newsletters. This step will save you the effort of 
re-entering your basic information and images every time 
you create a newsletter.

To save your document, select File from the tool bar at the 
top of your screen. 

Select Save As.

Rename your document  to distinguish it from your 
template and store it in a newsletter file on your computer.

Creating Your 
Newsletter Footer

Saving Your Template

CO-OP LOGO

ADJUST YOUR LOGO

Creating Your Newsletter Banner (contin-

Similarly, you can add your co-op motto by double 
clicking on the lowest text box (with light blue letters, 
under the title) in the banner and entering your own text.

CO-OP MOTTO
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As you begin to add and edit text in your newsletter you 
may find it useful to guide your work with a grid to ensure 
that your text boxes and photos are lined up properly. To 
reveal the grid, click on the View tab on your tool bar at 
the top of your screen. A new bar will appear with options 
for viewing your document.  (If you have an older version 
of Word, Select View > Show).

Look for a stack of squares labeled Ruler, Gridlines, and 
Navigation Pane.  

Co-op leaders agree that a newsletter calendar is a 
useful tool to keep members informed about important 
upcoming dates and deadlines. We’ve created a simple 
format where you can enter important dates and events 
for the month ahead, including member birthdays and 
anniversaries. 

Place a check near Ruler and Gridlines to help manage 
your workspace. Clicking on Navigation Pane will reveal 
both pages of your newsletter on the left side of your 
screen. When you finish editing, return to View and 
uncheck Ruler and Gridlines to reveal your unlined 
document.  (If you are have trouble revealing the grid, see 
TROUBLESHOOTING, p. 11)

USE THE GRID!

CALENDAR

While CDF has provided a collection of home care related 
photos for your use, it’s always best to use photos from 
your own co-op. 

Try to use high-resolution photos for your newsletter, (250 
– 300 resolution or about 300 megabytes). Lower quality 
photos may look fine on your computer, but will likely 
appear fuzzy when printed. You can find out if your photo 
is good quality by right clicking on your photo and looking 
for its size. 

For example, by right clicking on this home care photo 
below, (found in the CDF Home Care Newsletter Photos 
file) and selecting Get Info, you’ll learn that the file is only 
about a half a megabyte, so you can see why it looks fuzzy 
in print. That size is fine for a printing a small picture, but 
it will blur when expanded.

While the photo you choose will likely be a different size 
than the space available you can adjust the size by clicking 
on the new photo, and moving your cursor to the bottom 
right of the image, where the small double headed arrow 
will appear. Drag that arrow up or down until you are 
satisfied with the size of the image.

To replace the template photo with your own, place your 
cursor over the existing photo above the News from the 
Office section and right click on it. You’ll see a menu of 
actions.

Choose Change Picture > From a File

Microsoft Word will take you to your personal files, where 
you can select your photo either from your own collection 
or from the photos CDF has provided. 

Click Insert 

Your new photo will appear.

START WITH A PHOTO

Re-open your customized newsletter template from your 
Word files.

Entering Your 
Newsletter Content

PHOTO QUALITY IS IMPORTANT!

ADJUST YOUR PICTURE

ADD YOUR OWN PHOTO

In your newsletter, encourage office visits 
by inviting members to stop by during their 
birthday month and collect a birthday treat, 
such as a gift card or co-op swag. 
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To replace the template text with your own office report, 
double click on the text box below the title. Place your 
cursor in front of the first word in the box and drag it down 
to the end of the text. Hit delete.

Begin typing in the now-empty space, or cut and paste 
text from an outside document. If you need more room for 
your article, lengthen the text box by dragging down the 
small square at the bottom. Be aware that if you lengthen 
your article, you may need to adjust the size or position of 
the textbox below.

CREATING YOUR OFFICE COLUMN

While your calendar will alert your members about 
upcoming dates, use this space to highlight and promote  
important events. Include specifics about place, time and 
contact info for RSVPs. Consider offering incentives for 
attendance!

Use the back side of your newsletter to provide important 
facts and analysis about the health of your co-op business, 
advice from experts, feedback from clients and strategies 
for recruitment. This is also a good spot to introduce new 
members and commend the accomplishments of long-
time members.

Introduce a new co-op member or celebrate the 
accomplishments of an experienced provider in this space. 
Exeprienced co-op leaders recommend this section as a 
way to connect members whose schedules may not allow 
them to meet in the office.

Replace the photo and text as you did on page 1.

PLANNING 

THE FLIP SIDE

MEMBER SPOTLIGHT

To add your dates and events, double click on the text 
boxes in the calendar space and replace the existing text 
with your own. Make sure to keep the dates bold and 
your events regular text to distinguish the two.

While providers may no longer need to visit the office 
frequently, they do appreciate being kept up-to-date on 
developments that affect their daily work. Encourage 
your office staff to stay in touch by submitting a ‘News 
from the Office’ column monthly. Items of interest might 
include changes in office hours, technology upgrades, 
announcements about physical and staff changes in the 
office and invitations to office events.

NEWS FROM THE OFFICE

Entering Your Newsletter Content (contin-

WHAT WE’RE HEARING

Has your office received a note of thanks from a client or 
a client’s family?  Take a picture of it and place a copy in 
your newsletter, or just re-type the content of the note in 
this box.  Providers will appreciate the recognition.
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More Ideas for 
Newsletter Content
The following is a list of other helpful content to include 
in your newsletter. For some content ideas, you can find 
formatted space and examples of the content in Newsletter 
Templates 2, 3 and 4.

Inspire your members with occasional reminders about 
why working at a co-op is best for providers and for 
clients. The Co-op Difference is a space in your newsletter 
to display simple graphics that highlight the benefits 
of a co-op business. You can find sample graphics and 
diagrams in CDF’s Newsletter Resource Page.

To replace the current graphic with a new one, right click 
on the existing graphic and replace and adjust as you 
would a photo by selecting Change Picture. 

Although home care is projected to be one of the fastest 
growing occupations in the United States, recruitment 
continues to be a challenge for the industry. Home 
care co-ops have a built-in recruiting advantage – the 
experience and enthusiasm of their members. Use your 
newsletter to equip providers to be your best recruiters 
with facts and information they need to help build the 
business. 

You can find a file of compelling facts to support your 
recruiting efforts on the CDF Newsletter Resources web 
page. 

Select Newsletter Written Content

Open Co-op Difference Fact Sheet

The Recruitment Corner section can also be used for 
announcements about recruitment incentive programs 
and initiatives. Edit the text here the same way you edited 
the News From the Office column.

Introduce new board members, provide updates about 
important board business and encourage members to 
step up for leadership positions.

The Co-op Difference

RECRUITMENT CORNER

BOARD BUSINESS

Recruitment and retention are perennial challenges for 
home care cooperatives. Make your members part of the 
solution by ensuring they are informed about trends in 
the business. Report on new hires, recent departures, the 
number of providers currently employed as well as office 
staff and RNs. 

Provide members with some analysis to help put the 
staffing and financial numbers in context.  Put this 
month’s numbers in the context of the year and discuss 
whether they fit into the business’ strategic plan.

Caretakers who are not able to visit the office often miss 
opportunities to talk through work challenges with 
colleagues. Use this space as an advice column – solicit 
a work question from a newer member and ask an 
experienced provider to respond. Or ask a provider to 
share a strategy for overcoming a difficult work challenge.

HOW ARE WE DOING?

STAFFING REPORT

WHAT THE NUMBERS MEAN FOR US...

CAREGIVER’S CORNER

Entering Your Newsletter Content (contin-

Informed business owners make wise choices. Keep your 
membership apprised of the health of their co-op with 
regular and specific financial information. Remind them 
of their stake in the business by sharing income and 
expenditure data. Report progress in client acquisition 
and member recruitment.  

This section, and the Staffing Report section below 
contain a table so you can enter your numerical 
information in an orderly way.  Edit the cells of the tables 
as you would a regular text box.

INFOGRAPHICS

Infographics can often illustrate your point more 
succinctly than words.  Access some of the graphics CDF 
has made available through the CDF Newsletter Resources 
page. 
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Printing and Saving 
Your Newsletter
Once you’ve completed your newsletter, click on the 
File tab on your tool bar and select Save As  Name your 
document and then click on the Save button.

To print, select the File tab again and select Print. Check 
your settings and then press Print again.

If you want to email your newsletter as well as share 
printed copies, save a copy as a PDF file first to preserve 
your formatting. To create a PDF, return to the File button, 
click Print again and look for the small PDF box on the left 
of the print screen. Click on the arrow next to the PDF tab 
and select Save As PDF. Rename and save your document 
to your files.

PREPARING YOUR NEWSLETTER FOR EMAIL

WHOSE PET IS IT?

CO-OP SWAG: WEAR IT 

• You’re speaking. We’re listening.
• News and Pics From the Annual/Quarterly Meeting
• Facts to Inspire
• Holiday Celebration
• News From the Home Care Co-Op World
• Member Survey
• Training and Education
• Caregiver of the Year
• Get Feedback: Provider Reviews

OTHER IDEAS

A PART OF THE COMMUNITY

More Ideas For Newsletter Content (contin-

Invite co-op members to submit photos of their favorite 
pets.  Challenge co-workers to match the pet with the 
owner.  Winner gets a treat!

Start a swag contest!  Include pictures of members 
wearing or carrying their co-op gear in style.  Spread the 
word about your business by encouraging members to 
show off your logo wherever they go.

Strong cooperatives have strong relationships in the 
community.  Every community has leaders and people 
who care about those who need personal care. Reaching 
out to leaders and building relationships helps the 
community see caregivers as a core part of any solution.  
Highlight your cooperative’s connection to the community 
with pictures and stories about your outreach.
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Troubleshooting

Ooops! Did you delete the text box? No worries. Just press 
Control + Z  or Command + Z if you have a mac.  You can 
also click the undo button at the top left of the screen. (It’s 
a curved left-pointing arrow.)  Your previous entry will be 
restored.

REVEALING THE GRID

If you are using Word 2016, and are having trouble 
revealing the gridlines, try this solution:

1) Go to Word and click the arrow on the Quick Access 
Tool bar as below:

2) Select All Commands in the ‘Choose Commands from’ 
selection box.

3) Find Grid Settings and click on the arrow on the right, 
and then Save.

4) Click the Grid Settings  box on your toolbar and change 
the setting as the following:

5) Go to View again and check Gridlines.

RESTORING AN ACCIDENTAL DELETE

MOVING PHOTOS AND TEXT BOXES

To move or delete a text box or photo in your newsletter, 
right (or control) click on the text box or image.  A thin blue 
frame will appear around the image or text with a control 
icon in the center.  Drag the image or box to wherever you 
want to place it and then click outside the box.  Use your 
gridlines to ensure proper alignment.

FORMATTING PROBLEMS FROM USING AN 
OLDER VERSION OF WORD

If, upon opening your template, you find that the 
formatting looks awry, it may be a problem caused by 
incompatibilities between older and newer versions 
of Microsoft Word.  CDF has provided versions of the 
template using Word 2008 that may work better for you.  
Return to CDF’s  Home Care Cooperative Initiative web 
page and look for the Newsletter Templates (Microsoft 
Word 2008) link on the Newsletter Toolkit Resources page.
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Template 1
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Template 2
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Template 3
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Template 4
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